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     Monday February 10, 2003

At
 Lawrence Library

Meetng Rooms 1 & 2
US Route 1 South & Darrah Lane, Lawrenceville, NJ

Meetings of  an organization at any of  the facilities of  the Mercer County Library System
in No Way implies endorsement of  its programs

E-Bay
Buying & Selling!

Martin Mosho and  guest will explain the tricks
of buying and selling all types of merchandise

via the Web’s largest auction site.

Presidents message
By: Clarke Walker

Because January 1, 2003 was on a Wednesday we in the Princeton area were treated to three excellent computer oriented meetings during the week of
January 12th.  Of  course we had our meeting that Monday evening.  On Tuesday (2nd Tuesdays of  the month) the Princeton Macintosh Group met at
Jadwin Hall on the Princeton University campus.  They had a local speaker talk about creating video movies with the Macintosh.  Then on Thursday (3rd
Thursday of  the month) the Princeton Chapter of  the ACM and IEEE group met at Sarnoff  Labs.  At this meeting Professor Ed Felton spoke on The
Freedom to Tinker.

Also on the first Tuesday of  the month the Princeton Library holds a technology talk.  Last month Doug Dixon, who spoke to us in September, gave a
similar talk about The Digital Papyrus.

Like our group these other groups open their meetings to the public.  I encourage you to check at their web sites and visit them.
Their web sites are:

ACM/IEEE Princeton Chapter http://www.acm.org/chapters/princetonacm/
Princeton Library http://www.princeton.lib.nj.us/programs/adultprograms.html#tuesday
Princeton Macintosh Users' Grouphttp://www.pmug-nj.org/

Would some one like to give a talk on genealogy?  Or know some one who could?

Finally, I want to thank everyone who voted for me to be your new President.  And a special thanks to the other officers.
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About PPCUG
General Meetings

Second Monday of the month at the Lawrenceville Library.
Route 1 & Darrah Lane.

7:00-7:45 PM: Social Time
7:45 PM: Meeting Comes to Order

8 PM: Featured Presentation
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At this time of  year many people are still paying holiday bills and their
pockets are a little light. So I am going to revisit the subject of  obtaining
free software from the Internet. Even in today’s climate of  “product acti-
vation” and increasingly stringent licensing requirements, there remains a
surprising amount of  good software that is free and obtainable just by down-
loading. To be sure, there is a lot of  junk that is offered, but many quite
useful and well-written programs are available. Many of  them are from
individuals trying to establish themselves as reputable writers of  software
or from small companies that wish to introduce you to their products. Quite
a few are European, with a substantial Russian contingent these days. Al-
though a lot of  supposedly “free” software turns out to have strings at-
tached, there are some genuinely free and useful programs. I will consider
only this latter type and will not discuss shareware, trialware, adware, and
other similar types that come with restrictions.

Everybody has their own favorites but in this article I will mention a few
of  the programs that I personally like. Please keep in mind the usual cave-
ats that whatever you download should be checked for viruses and that
nothing should be installed without backing up first.

An Excellent Graphics Program
I will begin with an all-time favorite, IrfanView 32. Over the years I have

recommended this graphics program many times. Its author (Irfan Skiljan,
a Bosnian living in Austria) has updated the program numerous times and
has continued to add new functions. It is presently in version 3.75. Anyone
who does not need a full-fledged (and expensive) graphics program like
PhotoShop or Paint Shop Pro will find that this program serves most graph-
ics needs. It is far superior to the accessories that come with Windows
such as the Kodak imaging applet. It supports dozens of  file formats and
has numerous editing functions. In many ways it is the epitome of  what a
freeware program should be like. It is very fast and compact. There is no
EULA and installation makes no system or Registry changes.  If  you want
to associate various graphics file types with the program, you can do so but
the choice is up to you. In addition to many editing functions, the program
also has features such as creating a slide show, batch conversion, and twain
support for scanning. To illustrate some of  the features available, Figure 1
shows the File menu and Figure 2 shows the Image menu from the pro-
gram. There are also other menus with additional functions.

The program can be downloaded at numerous sites, including http://
irfanview.tuwien.ac.at/english.htm. It is completely free with no strings but
the author deserves a contribution for his efforts.

Figure 1.  File Menu for IrfanView
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Something Free
By: Vic Laurie - PPCUG
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Faxing from Windows XP
By: Don Arrowsmith - PPCUG

Faxing has always seemed like a relic of  an older age to me, but there are
situations when it just can't be avoided.  If  you have Windows XP (Home or
Pro) and an internal or external modem that supports fax (and most do), you
have all you need to handle sending and receiving faxes from the comfort of
your home.

 
The software isn't installed by default with Windows XP but it's easy to

add.  Look at MS Knowledge Base article 306550 (http://
support.microsoft.com/default.aspx?scid=kb;en-us;306550) for a step by
step procedure.  In a nutshell, you use the Add or Remove Programs control
panel and select Add/Remove Windows Components.  Pick Fax Services,
insert your Windows CD, and proceed to have the necessary files copied to
your hard drive.

 
The Fax Service must be configured before you can use it.  See the same

MSKB article for the step by step list. You will be adding a name and phone
number to be added to outgoing faxes (TSID) and to be returned to the
sender when receiving faxes (CSID).  You can also pick whether and how
you want to receive faxes. Enabling the service to receive a fax will tie up
your modem at all times.  This may be problematic if  you use a dialup ISP! 
If  you can make your modem always available for faxing, you can choose
between Automatic and Manual answer.  If  you have only one phone line,
you will probably want to set Manual answer.  Other options include auto-
matic printing and saving an archive copy of  received faxes.  If  you need to
modify any of  your answers at a later time, go to Start - All Programs -
Accessories - Communications - Fax - Fax Console.  In the Console, select
Configure Fax from the tools menu.

 
Look at MSKB article 306662 for information on receiving faxes.  If  you

have set up to Automatically receive faxes, the phone will be answered when
it rings and the fax will be processed without intervention.  When set to
manually receive a fax, a Receive Now button will appear in the taskbar that
can be clicked to begin the reception.  Other ways to begin receiving are
from the File menu of  the Fax Console or from the Fax Monitor.  The Fax
Monitor can be started from the Tools menu of  the Fax Console and pro-
vides progress updates.

 
The left pane of  the Fax Console includes four folders: Incoming, Inbox,

Outbox, and Sent.  Incoming contains faxes currently being received.  When
they have completed, they will move to the Inbox.  After you select the Inbox,
the received faxes will appear in the right pane along with a date/time, orig-
inating fax number, size in bytes and pages, and a status indicator (Success,
etc.).

 
You can then double click on a fax to have it open the Windows Picture

and Fax Viewer.  This is the same application that runs when you double
click a picture file from Windows Explorer.  You have the same options
available along the bottom for Printing, Rotating, Zooming, Saving, etc. 
Alternately, you can right click the fax from the Console to select Save As,
Print, Delete, etc.  Faxes will also stay in the folder until deleted.

 
Sending a fax can be done directly from the Picture and Fax Viewer or

almost any Windows application by choosing Fax as the printer to use.  See
MSKB article 306663 for guidance on how to fax a scanned document or a
picture file and article 306661 to learn how to fax directly from a Windows
program. Once you have directed your printing to Fax and clicked on Print,
the Send Fax Wizard will begin.  The first item concerns to whom to send
the fax.  You can enter names and numbers directly on the form or you can
use your address book.  Multiple recipients can be entered.

 
I use Outlook 2000 and have entered Contacts with their fax numbers for

my usual recipients.  If  either a home or business fax is listed, that number is

used.  If  both are listed, a box appears asking for you to pick one.  Of  course,
an error appears if  no fax numbers are listed.  I suggest that telephone num-
bers be entered in canonical form and that you have dialing rules set for your
location(s).  This allows Windows to correctly dial the number by including
or suppressing the area code for the recipient.  It will make your life much
easier if  you ever move, the phone company changes you to 10-digit dialing, or
if  you use a laptop at different locations.  Make sure that you have included
the code to defeat any Caller ID tones if  you have that feature on your line
(usually *70,).

 
The next screen will ask about a cover page.  If  you initiate the fax by

choosing "Send a Fax" from the File menu of  the Console, you MUST send
a cover sheet that includes at least a subject or notes.  Preconfigured cover
sheets are selected from a drop down list.  There is also a Fax Cover Page
Editor application to design your own personal cover pages.  These are stored
in the Fax folder of  My Documents and will also be available in the drop
down list.  MSKB article 306657 discusses fax cover sheets.  If  you begin
the wizard from an application, a cover sheet will not be required.  The last
screen of  the wizard lets you assign a priority and specify when to send the
fax - either immediately or at a later time.

 
Faxes to be sent appear in the Outgoing folder of  the Console along with

their status.  When the fax is actually being sent, the Fax Monitor will appear
and will display progress updates along with sounds during the call.  If  the
called fax number is busy or a connection cannot be made, the fax will be
rescheduled for a later time.  Information about the retry will be listed in the
Console.

 
Once the fax has been sent successfully, it will be moved to the Sent fold-

er of  the Console.  As with incoming faxes, you can double click on a fax to
see it in the Picture and Fax Viewer.  These faxes are actually copies of  the
original documents and will remain here until deleted.  You can delete them
from the Console by right clicking and choosing "Delete".

 
This software is very easy to install, easy to use, very reliable, and has all

the options I have ever needed.  It's much more convenient than running
off  to the drugstore or Staples and I highly recommend it.

The meeting opened at 7:50 with new president Clarke Walker asking
for suggested topics for future meetings. Some ideas presented were: to
have members bring and describe their digital cameras; photo printers;
Flash software. Q&A included deleting temporary folders and Panda Anti-
virus.

At 8 PM Paul Kurivchack began the main presentation on using Power-
Point. He started a short, self-running slide show with an example of  each
of  the basic types of  slides that can be made. These included the use of
sounds, graphics, transitions, an org chart, font styles, sizes and colors. Paul
then started a new presentation with PowerPoint and showed in detail how
each slide was created. He began by stressing the importance of  setting up
proper tile and slide master slides. Care spent on these will make later chang-
es much easier. This link to a Microsoft site contains numerous tips for
using PowerPoint: http://search.office.microsoft.com/assistance/
producttask.aspx?p=PowerPoint.

The formal meeting ended at 9:10.

General Meeting Minutes
January 13, 2003
By: Don Arrowsmith - Secretary PPCUG
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Figure 2.  Image Menu for IrfanView

Protecting Yourself  on the Internet
As the Internet has become truly global with hundreds of  millions of

participants, the number of  annoyances and hazards has escalated. For ex-
ample, viruses in attachments and the clogging of  mailboxes with spam
have become problems affecting all who use e-mail. Hackers try to plant
Trojans on the computers of  unwary surfers. Advertising techniques on
web sites have become increasingly aggressive and intrusive. The various
problems have been discussed in some detail in previous articles, which
can be read at www.vlaur.com. Here I will mention a few of  the many
programs that are available to deal with these problems.

MailWasher- For those who do not have really heavy mail volume (and
do not use AOL) this may be the single best program available for filtering
e-mail. It works on any POP3 mail server. With it, you can check out mail
on the mail server (or multiple servers) before you have actually down-
loaded the mail to your own computer. Any mail that you do not want you
can delete directly from the server(s). You can also bounce unwanted mail
back to the sender with a message that you are unknown at that address.
Although spammers will likely ignore (or not even receive) these bounces,
there is a certain psychological satisfaction in zapping spam. Addresses of
known spammers and other undesirables can be put on a blacklist. This
program is also a good way to avoid inadvertently opening dangerous at-
tachments.  Message bodies and headers can be previewed while messages
are still on the server, giving you a chance to assess mail before download-
ing it. Viewing message bodies before downloading also precludes any
HTML “bugs” from telling spammers that the message has been read. Fig-
ure 3 shows some of  the available options.

 The program is available at http://www.mailwasher.net.  It can be used
without payment but it comes with an unobtrusive scrolling section asking
that it be registered with a contribution.

ZoneAlarm- These days everyone who uses the web should have a fire-
wall. There are good commercial ones but the excellent free version of
ZoneAlarm from ZoneLabs should be sufficient for most home PC users.
ZoneAlarm also comes in a commercial version for businesses or those
who want some more features. Firewalls are necessary, not only to keep
hackers from coming into your computer, but also to keep Trojan horses
and spyware from using your computer to send out to the Internet. Note
that the firewall that comes with Windows XP can only block incoming
probes and does not monitor outgoing signals. For that reason, I do not
regard the XP firewall to be sufficient protection and I believe that it should
be replaced. Make sure to disable it before installing another firewall. Only
one firewall at a time should be running. ZoneAlarm is available at  http:/
/www.zonelabs.com/store/content/home.jsp. Look for the link to the free
version.

AdAware and  Spybot S&D- As  spyware becomes more and more preva-
lent, anyone who downloads any programs from the web needs to have the
ability to check for hidden software that might be running on their system.
One of  the most widely used programs is AdAware from LavaSoft. It can
be downloaded at http://www.lavasoft.de. However, some people have
recently been complaining that the program is not being kept up to date
although LavaSoft has promised that a new version (6.0) will be coming
soon. An alternative program is Spybot Search & Destroy, which can be
downloaded at http://spybot.eon.net.au

Pop-Up Stopper- To help combat those annoying, in-your-face advertising
tactics on the web such as pop-ups, use the free program, Pop-Up Stopper,
available at http://www.panicware.com/product_downloads.html. (Does
not work with AOL) There is also a heftier, commercial version. Note of
caution: not all pop-up windows are bad.  Sometimes you will block a win-
dow that you actually want. Holding down the CTRL key will temporarily
allow pop-ups.

PC Magazine
I will end this article by mentioning the veritable treasure trove of  use-

ful freeware that is available from PC Magazine at http://www.pcmag.com/
category2/0,4148,2130,00.asp.  Over the years, Neil Rubenking and his
colleagues have performed a real service to the computing community by
turning out one handy application after the other. In past articles, I have
mentioned many of  these, including StartUp Cop, Cookie Cop, ContextE-
dit, and EndtItAll, Although some of  the older ones may not work in Win-
dows XP, updated versions of  many are available. All that have been writ-
ten since XP came out are compatible with Windows 98/Me and XP. A
recent one that I like is UnClean 2.0, which provides an improved uninstall
process. PC Magazine now requires registration in order to download but
the benefits are well worth this small inconvenience. Registration is free.

Something Free  continued from page 2

Figure 3. MailWasher options
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http://www.ppcug-nj.org
PPCUG Member E-mail Directory

(Last Update: Febuary 1, 2003)
Send Updates to kurivchp@optonline.net for inclusion in this listing.

Name E-Mail
Last First Address

Name E-Mail
Last First Address

Consultants Corner

Meyda Online
“Meyda means Information”

J.D. Abolins
“Pro Bono” Educational Services

Specialties: Information Security, Privacy Issues,
and Web Publishing

http://www.meydabbs.com
E-mail: jda-ir@njcc.com

Consultants Corner
You can advertise your consulting business for $25 per year in addition to your

normal membership fee.

Abolins John D. jda-ir@njcc.com
Adler Seymour syadler@aol.com
Arrowsmith Donald L. donaldarrowsmith@yahoo.com
Axelrod Albert aaxelrod@nerc.com
Best John J. jjbest57@alum.mit.edu
Bolge Eleanor embolge@jersey.net
Briggs George R. grolbriggs@aol.com
Budelis Joseph Joe_Budelis@post.Harvard.edu
Canavan Thomas canavan1@aol.com
Caris Paul D. pcaris@earthlink.net
Carman Thomas tom_carman@compuserve.com
Castro Carlos carlos.castro@ieee.org
Chilton Neal W. chilforce@aol.com
Cohen Jon jon@njcc.com
Colucci Frank E. DasWeb1@aol.com
Crossley Helen M. CrossleyHM@aol.com
Davis Perry J. perrydavis@compuserve.com
Dinkins-Belton Joyce Joyce8NJ@aol.com
Dodge William B. b-mdodge@juno.com
Duggins Marsha msd@gfol.noaa.gov
Edge, Jr. Lewis A. lewis@edgeassoc.com
Einthoven Bella einthoven@mail.eclipse.net
Foulkes Frank ffoulkes1@aol.com
Gibson Dawson H. gibbygib@worldnet.att.net
Goldenberg Kim kgolden3@optonline.net
Gunther Bruce W. bg1509@hotmail.com
Hansen George gphansen5@yahoo.com
Hardy Wayne wayne99@att.net
Hawryluk Bill bhawr@aol.com
Henry Chuck chenry130@comcast.net
Holly Lois lois@audet.com
Johnson Florence kredit@nerc.com
Juelch H. Karl karljnj@nerc.com
Kerslake David AcuraOwner@aol.com
Ketchel Joseph buddyjoe227@aol.com
Keinerman Irma rafiki@iopener.net
Kleinerman Milton kukumafi@Juno.com
Konvalinka John W. jkonvalinka@msn.com
Koosman Milton miltonk2@aol.com

Krisak Bill BobKrisak@worldnet.att.net
Kurivchack Paul kurivchp@optonline.net
Landis Houston E. judge@alumni.princeton.edu
Laurie Vic hampsi@yahoo.com
Lazar Joseph joelazar@nerc.com
Lewis Lloyd N. Budnorth@juno.com
Libes Sol sol@libes.com
Markward Margaret mteragram@aol.com
Metzler Joseph 76116.3117@compuserve.com
Middleton Frank ftmprob@nerc.com
Miller Douglas E. D.N.Miller@worldnet.att.net
Mintz Herman hmintz4@aol.com
Montani Linda l.montani@worldnet.att.net
Mooney William P. wmo8350722@aol.com
Mosho Martin martinmosho@att.net
Oldenburg Thomas A. oldenburg-ta@worldnet.att.net
Olson Gaylord go@electrim.com
Papier, Jr. Philip B. papierp@bellatlantic.net
Phadke Laxman G. lgphadke@comcast.net
Pitcher Barbara bpitcher@ets.org
Rothstein Rick rich_web@email.com
Shinkfield David d.shinkfield@worldnet.att.net
Sked Bill billsked@aol.com
Stockwell Hunt hunt.stockwell@cornell.edu
Suber Michael J. mpsuber@juno.com
Tafel David E. dtafel@comcast.net
Tayyabkhan Mike tayyabkhan@aol.com
Walker Clarke Clarke_Walker@compuserve.com
Tenner Edward tenner@clarity.princeton.edu
Vanisko Thomas L. tlvanisko@aol.com
Walthall Ronald K. ronwalthall@prodigy.net
Weinberg Robert bweinb@comcast.net
Weiss III Edward A. eweiss@nerc.com
Williams Ken krw1948@worldnet.att.net
Willis Robert S. rsw9999@cs.com
Willis Lloyd lwillis1@prodigy.net
White Jonathan A. jawhite@yes-llc.com

January 13, 2003 – Monday

February 10, 2003 – Monday

March 10, 2003 – Monday

April 14, 2003 – Monday

May 12, 2003 – Monday

June 9, 2003 – Monday

July 14, 2003 – Monday

August 11, 2003 – Monday

September 8, 2003 – Monday

October 20, 2003 – Monday* - Third Monday

November 10, 2003 – Monday

December 8, 2003 – Monday
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Here’s a new utility that members might find useful.  Disk Investigator is freeware.

Disk Investigator™ Version 1.3 -- FREEWARE - (Only 0.5 Mb)

Discover all that is hidden on your hard disk - (for Win95, Win98, WinME, WinNT, Win2000, WinXP) -

What is Disk Investigator? - Disk Investigator helps you to discover all that is hidden on your computer hard disk. It can  also help you to recover lost
data.

Display the true drive contents by bypassing the operating system and directly reading the raw drive sectors. View and  search raw directories, files,
clusters, and system sectors. Verify the effectiveness of  file and disk wiping programs. Undelete previously deleted files.

Download at: http://www.theabsolute.net/sware/dskinv.html

There is no restriction against any non-profit group  using the article as long as it is kept in context, with proper credit given to the author.  This article
is brought to you by the Editorial Committee of  the Association of  Personal Computer User Groups (APCUG), an International organization to which
this user group belongs.

Disk Investigator™
By: Robert A Lewis, The Dayton Microcomputer Association, Inc. Dayton, OH


